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The Policy Simulation Group (PSG) offers three computer simulation models
that together produce aggregate financial estimates and individual distributional
estimates for both the government social security system and the employer-
sponsored pension system in the United States.

SSASIM is a cell-based actuarial (CBA) model of social security trust fund
solvency plus an simulator of social security benefits, taxes, and money’s worth
statistics for a handful of exemplary cohort individuals (ECI). Both the CBA
mode and ECI mode models can be driven by either deterministic or stochastic
projections of key macrodemographic and macroeconomic assumptions, as in
the annual OASDI Trustees Report.

PENSIM is a microsimulation model of employer-sponsored pension (ESP)
benefit accumulation and withdrawal behavior that is driven by the macro pro-
jections generated by SSASIM and produces estimates for a sample of individ-
uals born in a specified year.

GEMINI is a microsimulation model that simulates social security benefits,
taxes, and money’s worth statistics for a representative cohort sample (RCS)
generated by PENSIM. The GEMINI microsimulation results for many over-
lapping cohorts (OLC) can be aggregated by SSASIM into social security trust
fund solvency estimates.

Working together, the three models can produce estimates of retirement
benefits from pensions and social security under a wide range of assumptions
concerning employer-sponsored pension offerings and government social security
policy.

Contents

This short primer contains the following sections:
Capabilities of PSG Models (page 2) provides a brief description of how the

three models work together.
Installation of PSG Models (page 6) provides a description of how to install

the models on a Windows computer.
Operation of PSG Models (page 13) provides a number of descriptions about

how to accomplish common tasks using the models. This section consists of
answers to a series of “How do I . . . ?” questions.
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Capabilities of PSG Models

The three PSG models cooperate in a variety of ways to produce different
kinds of estimates concerning the government social security program and the
employer-sponsored pension system. The easiest way to explain the nature of
this model cooperation is to characterize PENSIM and GEMINI as SSASIM
add-ons. Of the three models, only SSASIM can operate on its own, but its
most useful optional modes of operation require assistance from both PENSIM
and GEMINI. PENSIM always requires assistance from SSASIM, and GEMINI
always requires assistance from both SSASIM and PENSIM.

The nature of PSG model cooperation will be described by explaining how
the models work together in each of five SSASIM modes of operation. As each
SSASIM mode of operation is discussed, the reader will find it useful to refer to
Figure 1.

SSASIM

in out env

PENSIM

in out coh

GEMINI

in out olc

Figure 1: Links between PSG Models. The inputs and outputs of each model
are represented by circles below the model. The in circle represents the input
database, the out circle represents the output files, the env circle represents the
binary environment file, the coh circle represents the binary cohort file, and the
olc circle represents the binary overlapping cohorts file.

Cell-Based Actuarial (CBA) Mode. This mode of SSASIM operation pro-
duces trust-fund solvency estimates using actuarial methods that represent the
population as a collection of aggregate age-gender cells. These methods are sim-
ilar to those used to produce estimates shown in the annual OASDI Trustees
Report. While the average impact on each cell is easy to determine for reforms
that have proportional effects across individuals, things are more difficult for
reforms that have have non-proportional effects across individuals. As with
the Trustees Report model, estimating the effects of reforms that have non-
proportional effects requires use of a supplementary sample of individuals to
estimate the average impact on each cell. A suitable supplementary sample,
the Benefits and Earnings Public-Use File, is available from the Social Security
Administration (SSA) Office of Policy website 〈http://www.ssa.gov/policy/〉.
See the “How do I characterize reforms in CBA mode?” section of the Get-
ting Started with the RSF Toolkit document for details about how to represent
reforms in the CBA mode of operation.
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The CBA mode of operation requires only SSASIM. SSASIM does not re-
quire an olc file as input and does not produce an env file as output.

Single-scenario, deterministic-assumption CBA mode runs execute almost
instantaneously on any Windows computer. CBA mode runs with stochastic
assumptions take somewhat longer. On an AMD Opteron 280 chip running at
2.4 MHz, it takes about 1.5 minutes to execute a CBA mode run that assumes
current-law policy and uses 1000 stochastic scenarios of 85 years length.

Exemplary Cohort Individuals (ECI) Mode. This mode of SSASIM op-
eration produces a wide range of benefit adequacy and money’s worth estimates
for as many as nine men and nine women born in a specified year and whose
life histories are specified by the model user. If these exemplary individuals are
specified to be married, then the same statistics are produced for each couple
as well as each individual. This mode produces results for individuals with styl-
ized life histories similar to those presented in SSA Office of the Chief Actuary
solvency memoranda.

The ECI mode of operation requires only SSASIM. SSASIM does not require
an olc file as input and does not produce an env file as output.

The run execution times for ECI mode runs are the same as for CBA mode
runs.

Employer-Sponsored Pension (ESP) Mode. This mode of SSASIM op-
eration produces PENSIM estimates of employer-sponsored pensions for a rep-
resentative sample of individuals born in a specified year. The birth year and
size of the sample are specified by the model user. The estimates are written to
PENSIM output files located in the PENSIM database folder.

The ESP mode of operation requires SSASIM and PENSIM. SSASIM does
not require an olc file as input and produces an env file as output. PENSIM
requires an env file as input and does not produce a coh file as output.

ESP mode runs involve PENSIM life history calculations and employer-
sponsored pension calculations, but no GEMINI social security calculations.
On an AMD Opteron 280 chip running at 2.4 MHz, it takes about 1.5 minutes
to execute a single-scenario ESP mode run that uses baseline pension assump-
tions, a 2.0 percent sample of the 2000 birth cohort, and 2011 Trustees Report
assumptions.

Representative Cohort Sample (RCS) Mode. This mode of SSASIM
operation produces GEMINI estimates of social security benefit adequacy and
money’s worth for a representative sample of individuals born in a specified
year. The estimates for each individual are similar to those produced in the
ECI mode. The birth year and size of the sample are specified by the model
user. The estimates are written to GEMINI output files located in the GEMINI
database folder.

The RCS mode of operation requires SSASIM, PENSIM, and GEMINI.
SSASIM does not require an olc file as input and produces an env file as out-
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put. PENSIM requires an env file as input and produces a coh file as output.
GEMINI requires a coh file as input and does not produce an olc file as output.

RCS mode runs involve PENSIM life history calculations as well as employer-
sponsored pension calculations, and GEMINI social security calculations. Pen-
sion benefits are calculated for two reasons: (a) in order to calculate social
security benefits accurately under WEP/GPO benefit reduction rules, and (b)
in order to provide a more comprehensive estimate of total retirement income.
On an AMD Opteron 280 chip running at 2.4 MHz, it takes about 2.5 minutes
to execute a single-scenario RCS mode run that assumes current-law social se-
curity policy, uses a 2.0 percent sample of the 2000 birth cohort, and adopts
2011 Trustees Report assumptions.

Overlapping Cohorts (OLC) Mode. This mode of SSASIM operation pro-
duces trust-fund solvency results using microsimulation methods that represent
the population as a sample of individuals born in many years. These methods
are similar to those used by CBO to produce social security estimates using the
CBOLT model. The solvency statistics produced in the OLC mode are the same
as those produced in the CBA mode. But the use of microsimulation methods
eliminates the need for the supplementary sample required by the CBA mode
to analyze reforms that have non-proportional effects on the population. The
size of the the cohort samples used in the OLC mode are specified by the model
user.

The OLC mode of operation requires SSASIM, PENSIM, and GEMINI.
SSASIM requires an olc file as input for each cohort born from 1935 through
the last year of the solvency simulation. SSASIM gets these olc files by asking
GEMINI to produce one for each cohort. GEMINI does this by asking PENSIM
for a coh file for each cohort simulated with employer-sponsored pensions. And
PENSIM does this by asking SSASIM for an env file. An OLC mode run with a
seventy-five year solvency test period using 2011 Trustees Report assumptions
requires 153 cohorts (1935–2087) to be simulated by PENSIM and GEMINI.
Social security benefits for cohorts born before 1935 are supplied by the CBA
mode.

In order to accelerate the execution of an OLC mode run, SSASIM can
request more than one cohort simulation at a time. This multi-threading logic
can take advantage of multiple chip computers and multiple core chips. Using
a computer with two dual-core Opteron 280 chips running at 2.4 MHz, a single-
scenario OLC mode run with 153 cohorts executes in about 3.0 minutes, when
it adopts 2011 Trustees Report assumptions, uses a cohort sample size of 0.1
percent (i.e., one-in-a-thousand sampling), uses eight threads, assumes current-
law social security policy, and simulates employer-sponsored pensions (to allow
accurate estimation of social security benefits using the WEP/GPO benefit
reduction rules). This means that the corresponding stochastic OLC mode
run with 500 scenarios takes about 25 hours to execute.

This long execution time for a single stochastic OLC run is why the Pol-
icy Simulation Group has developed a distributed processing capability that
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permits such a run to execute on twenty-five eight-core Linux servers rented
inexpensively by the hour from Amazon Web Services (AWS), a leading cloud-
computing vendor. Such an approach reduces the execution time of a stochastic
OLC mode run to about one hour. For more information, start the AWS Toolkit
from the RSF Toolkit Execute menu and select the getting started item on the
AWS Toolkit Help menu.

Combining Modes in a Single SSASIM Run. A single SSASIM run can
produce results from more than one mode. The SSASIM macro model produces
solvency statistics using either the CBA mode or the OLC mode. The possible
mode combinations for a single SSASIM run are as follows:

• Macro: CBA mode + Micro: ECI mode

• Macro: CBA mode + Micro: ESP mode and/or RCS mode

• Macro: OLC mode + Micro: ESP mode and/or RCS mode

When the ESP mode specifies PENSIM runs for more than one birth cohort,
SSASIM use multi-threading logic to execute the PENSIM runs simultaneously.
And when the RCS mode specifies GEMINI runs for more than one birth cohort,
SSASIM use multi-threading logic to execute the GEMINI runs simultaneously.
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Installation of PSG Models

The PSG models run only under the Windows XP/Vista/7 operating systems.
This section describes the procedure for installing the models, which is highly
automated. This section also explains which models are free and which models
require registration and payment of an annual subscription fee.

SSASIM comes in two versions: the educational version, which is free but
has one minor limitation, and the standard version, which is not free but has
no limitations.

PENSIM comes in one version: the standard version, which is free.
GEMINI comes in two versions: the educational version, which is free but

has one major limitation, and the standard version, which is not free but has
no limitations.

There is little reason not to install all three models. Whether or not you convert
from the educational to the standard versions of SSASIM and GEMINI depends
on your analysis needs and budget. Here are the installation options:

1. Edu-SSASIM. The educational version of SSASIM is free and requires no
registration; read below about the automatic SSASIM installation proce-
dure. This option provides the ability to produce social security estimates
using the macro CBA and micro ECI modes of SSASIM operation. The
educational version of SSASIM limits the number of macrodemographic
and macroeconomic scenarios to one, which means that stochastic envi-
ronments cannot be simulated.

2. Edu-SSASIM+PENSIM. Adding PENSIM to option 1 is free and re-
quires no registration; read below about the automatic PENSIM instal-
lation procedure. This option provides the additional ability to produce
pension estimates using the ESP mode of SSASIM operation. Read below
about how to avoid the limitation of the educational version of SSASIM
and conduct stochastic pension analysis.

3. Edu-SSASIM+PENSIM+Edu-GEMINI. Adding the educational
version of GEMINI to option 2 is free and requires no registration; read
below about the automatic GEMINI installation procedure. The edu-
cational version of GEMINI sets all OASDI taxes and benefits to zero,
which means it cannot be used to conduct social security policy analy-
sis. What this option does provide is the additional ability to analyze
PENSIM employer-sponsored pension estimates using GEMINI output
analyzer programs including the EDA Toolkit, which automates graphing
of distributional results. This is the basic installation of the PSG
models — it is completely free and requires no registration.

4. Converting Edu-SSASIM to Std-SSASIM. The educational version
of SSASIM can be converted to the standard version of SSASIM by regis-
tering and paying an annual SSASIM subscription fee; read below about
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the registration process and the SSASIM fee schedule. This option pro-
vides all the capabilities of the CBA, ECI, and ESP modes of SSASIM
operation without any limitations.

5. Converting Edu-GEMINI to Std-GEMINI. The educational version
of GEMINI can be converted to the standard version of GEMINI by regis-
tering and paying an annual GEMINI subscription fee; read below about
the registration process and the GEMINI fee schedule. This option pro-
vides, without any limitations, the additional capabilities of the macro
OLC mode of SSASIM operation (for solvency analysis) and the micro
RCS mode of SSASIM operation (for distributional analysis).

Using the standard versions of the three PSG models is the complete package: it
provides the ability to produce social security solvency and distributional esti-
mates under a wide range of social security policies using either deterministic or
stochastic characterizations of macrodemographic and macroeconomic assump-
tions, and it provides the ability to produce pension benefit estimates under a
wide range of assumptions about government pension policy, employer plan of-
ferings, and employee pension behavior, using either deterministic or stochastic
assumptions. Furthermore, the RCS mode can estimate both social security and
pension benefits for each individual in a large cohort sample. Given the ease
of specifying a model run, the speed of run execution, and the sophistication
of included output analysis and graphing capabilities, this package can support
an intensive program of retirement policy analysis conducted under time pres-
sure. The option of using the standard versions of all three PSG models has
been chosen by the Government Accountability Office (GAO), the SSA Office of
Retirement and Disability Policy, and various non-governmental organizations,
over the years.

Installing the educational version of SSASIM. The whole automated
installation process assumes that you have administrative privileges on your
personal computer. This is an increasingly rare situation in large organizations
and for those who have moved beyond Windows XP. If you need the assistance
of IT staff to do this installation, make sure the IT staff person reads this whole
section before attempting to conduct an installation for you. And don’t let the
IT staff person leave before you turnoff your computer, restart it logging in as
yourself, and can pass all the benchmark tests that are appropriate for your
particular installation of the PSG models.

Go to the Download page on the PSG website 〈http://www.polsim.com〉 and
double click on the Install SSASIM link to download and execute the SSASIM
installation program.

You are likely to be warned that the install-SSASIM.exe file is from an
unknown software publisher that does not have a valid digital certificate. Ignore
this warning and continue with the model installation.

This completes the basic installation of SSASIM. At this stage, you should
have the educational version of SSASIM working on your computer. In order to
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determine that the installation is correct, perform the CBA mode benchmark
test as follows:

CBA mode benchmark test
(a) Click on the red Tk icon to start the RSF Toolkit.
(b) From the Execute menu, select the CBA mode benchmark run item,

which will start the simulator executing the benchmark run in a separate win-
dow. If you can’t do this, there is an installation problem; read the “Solving
Installation Problems” section below.

(c) After the benchmark run has completed execution, the benchmark script
will invoke the compare-results utility to determine the validity of the run’s
output. If this utility reports any differences between the results just gener-
ated by the benchmark run (in the run*.* files) and the archive results (in the
rxn*.* files that are distributed with SSASIM), then there is a problem with
the SSASIM installation. If there is a problem, read the “Solving Installation
Problems” section below.

Once you have passed the CBA mode benchmark test, it is important to make
a few adjustments to Windows that will improve your experience working with
the PSG models:

(1) Make sure your screen resolution setting is not too low: a minimal setting
is something like 1280 x 768 pixels, while a better setting is something like 1440
x 900 pixels. Adjust the screen resolution by right clicking on your desktop,
picking the Properties (or Personalize) item on the menu that pops up, and
activating the (Display) Settings tab.

(2) Make sure you have the free Adobe Acrobat Reader (version 5.0 or higher)
installed. You will get the highest quality graphics from the Trust-Fund Sol-
vency (TFS) Toolkit if you also have Adobe Acrobat Standard or Professional
installed. And you need the Excel spreadsheet for the Exemplary Cohort Indi-
viduals (ECI) Toolkit to work.

(3) Revise the properties of the command prompt windows that SSASIM
starts frequently. Create a window in the SSASIM database folder by selecting
the Output from Windows command prompt item on the Analyze menu. Right
click that window’s title bar and select the Properties item (or the Default item
in Vista/7) on the menu that pops up. The Properties window has four tabs.
Click on the Options tab and make sure the Window Display Option and the
Quick Edit Mode are selected. Click the Font tab and select 8x12 if you want
an easier to read type size in the window. Click on the Layout tab and make
sure that the Width/Height are set to 80/4000 for the Screen Buffer Size and to
80/35 for the Window Size. And finally, click the Colors tab and select Screen
Text and Screen Background colors that are easiest for you to read (for example,
yellow on blue). If working under XP, click on the OK button, select the option
to “Save properties for future windows with same title”, and click OK again.
In the same way, start another Command Prompt window from SSASIM to
confirm that the properties you selected have been saved.

(4) Set the font used in the Windows Notepad program, which SSASIM
starts often, to a readable fixed-width font, such as Courier New, Regular, 10
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point, using the Font item on the Format menu in the Notepad.

Installing the standard version of SSASIM. Install the educational ver-
sion of SSASIM and make sure you can pass the CBA mode benchmark test, as
described on page 8. Then run the registration program: after creating a com-
mand prompt window in the SSASIM database folder by selecting the Output
from Windows command prompt item on the Analyze menu, enter register at
the command prompt. This will produce a file named register.zip; send an email
to holmer@polsim.comwith the register.zip file as an attachment. In return you
will get a personalized version of the ssasim.use file and a version of ssasimx.exe
that is registered to run on your computer. Switching from the educational to
the standard version simply involves replacing these two files that came in the
installation package. Arrangements will also be make for you to pay the annual
SSASIM subscription fee, which is $4,000 per registered copy.

Important note about installing on laptop computers. Registered versions of
the PSG models will not run on a laptop computer unless steps have been taken
to prevent battery-saving fluctuations in CPU chip speed.

Installing PENSIM. Install the educational or standard version of SSASIM
and make sure you can pass the CBA mode benchmark test, as described on
page 8. Then go to the PSG website Download page 〈http://www.polsim.com〉
and double click on the Install PENSIM link to download and execute the
PENSIM installation program. After the installation process is finished, make
sure you can pass the PENSIM benchmark test, which is analogous to the CBA
mode benchmark test described on page 8, except that you execute the ESP
mode benchmark run rather than the CBA mode benchmark run.

There is no registration or subscription fee required for the standard version
of PENSIM.

Installing the educational version of GEMINI. Install SSASIM and
PENSIM, as described above. After passing both the CBA mode and ESP mode
benchmark tests, go to the PSG Download page 〈http://www.polsim.com〉 and
click on the Install GEMINI link to download and execute the GEMINI instal-
lation program.

This completes the basic installation of GEMINI. At this stage, you should
have the educational version of GEMINI working on your computer. In order
to confirm this, make sure you can pass the ESP+ mode benchmark test, which
is analogous to the CBA mode benchmark test described on page 8, except
that you execute the ESP+ mode benchmark run rather than the CBA mode
benchmark run.

Installing the standard version of GEMINI. Convert the educational
version of SSASIM to the standard version of SSASIM; each standard version
of GEMINI requires a standard version of SSASIM. There is no separate regis-
tration required for GEMINI; the SSASIM registration information is sufficient.
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However, there is a separate annual subscription fee for GEMINI. The total
subscription fee is the same for one, two, three, four, or five registered copies of
GEMINI: $50,000 per year. The subscription fee for each additional registered
copy of GEMINI, beyond five copies, is $10,000 per year. Upon receipt of the
fee, you will receive a personalized version of the gemini.use file and a version of
geminix.exe that is registered to run on your computer. Getting the standard
version of GEMINI simply involves replacing these two files that came in the
installation package.

After you have a registered version of GEMINI installed on your computer,
make sure you can pass the GEMINI benchmark test, which is analogous to the
CBA mode benchmark test described on page 8, except that you execute the
RCS mode benchmark run rather than the CBA mode benchmark run. If you
pass this GEMINI benchmark test, you should also be able to execute the OLC
mode benchmark run successfully.

Solving Installation Problems. Three possible problems are discussed here.
(1) The most common problem with the automatic installation procedure

is that the PATH and model environment variables do not get set correctly. A
typical symptom of this situation would be that clicking on the red Tk icon
produces an error message something like “Windows cannot find ‘tclkit.exe’ ...”
even though tclkit.exe is in your SSASIM executables installation folder. To
remedy this problem it may be necessary to set several environmental variables
by hand. Follow the procedure below to do this:

Right click on the My Computer icon, select the Properties menu, and then
click on the Advanced (or Advanced System Settings) tab and the Environ-
mental Variables box. These operations will produce a window in which new
User (not System) variables can be changed. Edit the PATH and add three
new variables, using the Variable Name and Variable Value lines, so they look
something like this:

VARIABLE: VALUE:
PATH C:\SSASIM;C:\PENSIM;C:\GEMINI
ssasim C:\SSASIM
pensim C:\PENSIM
gemini C:\GEMINI

Be sure to leave no blank spaces in the value of the path variable. Note that
the above values for the variables are just examples. When you specify
the variable values, be sure to use the actual drive (C: or D: or some other
letter) and directory tree (\Users\username\SSASIM, for example) that describe
where the models have been installed. Also, note that this specification of the
environmental variables will work just fine even if you do not install the PENSIM
or GEMINI add-ons to SSASIM.

After specifying this change in the environment, the computer must be
restarted before the new environment will become effective.

If following this procedure does not solve this problem, send an email to
holmer@polsim.com with details about the problem you are experiencing.
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(2) Another type of problem is that the benchmark run starts executing,
but ends with an error. If the error occurs during a benchmark run, simply
select the View error.log file item on the RSF Toolkit Execute menu to view the
error.log in the Windows Notepad. Send an email to holmer@polsim.com with
the contents of the error message copied into the body of the message.

(3) Another kind of problem is that the benchmark run starts and completes
execution without an error, but there are differences between the output files
produced by the run (run*.*) and the archive output files (rxn*.*) that are part
of the model installation. In this case, send an email to holmer@polsim.com
with a list of the output files that have different results.

Solving Performance Problems. Given current computer hardware, the
problem of slow run execution is likely to be severe only for OLC mode runs,
especially if those runs use stochastic assumptions. The solution to this problem
is simple: run the PSG models on a computer with two dual-core chips or one
quad-core chip. And if you want to cut that execution time in half, move
up to a computer with two quad-core chips. Model run times will continue
to decline because both AMD and Intel have publicly announced that their
business strategy is to increase the number of cores on a single chip beyond four
(to eight and then sixteen) in future years.

Avoiding Limitations of Educational Version of SSASIM. As men-
tioned above, the free educational version of SSASIM cannot execute multiple-
scenario runs, which means that stochastic pension environments cannot be
simulated using the educational version of SSASIM and the standard version
of PENSIM. But this is not a serious problem, because PENSIM is distributed
with source code, a compiled library, and a complete sample program that shows
how to read and write env files. This free capability allows the creation of env
files that contain any number of scenarios with any annual values for the as-
sumption variables. The env file read-write programs are produced using the
open-source GNU C++ compiler (g++) operating in the MinGW environment
under Windows 〈http://www.mingw.org/〉. Unzip the env.zip file located in the
PENSIM executables folder and read the envsetup.bat file for details.

Uninstalling the PSG Models. The model installation procedure does only
four things: writes files into the specified installation folders, creates a program
icon (for the RSF Toolkit), adds the three installation directories to the user
PATH environment variable, and creates three model environment variables.
You can do a complete model uninstall by deleting the installation folders and
icon (by dragging the folders and icon to the Recycle Bin), removing the model
installation directories from the user PATH, and deleting the three new model
environment variables.

Information for IT Staff. The model install/upgrade programs are built
with the Inno Setup 5 compiler 〈http://www.jrsoftware.org/isinfo.php〉. Along
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with the PSG model files installed on the user’s computer, a program called
SetEnv.exe 〈http://xanya.net/site/display code.php?id=2&t=utils〉 is installed
and used by the install program to set the PATH and the three model-name
environment variables described above. There are a number of command-line
parameters that can be used to customize the operation of the install/upgrade
programs. A complete list of command-line parameters is available at the “Setup
Command Line Parameters” page under Other Information on the Inno Setup
help web page 〈http://www.jrsoftware.org/ishelp/〉. The most common cus-
tomizations are described here using a few examples.

First, the model installation directory can be controlled, and the setup wiz-
ard’s installation directory selection page can be suppressed, by invoking the
install programs in the following way:

install-SSASIM.exe /silent /dir=D:\PSG\SSASIM
install-PENSIM.exe /silent /dir=D:\PSG\PENSIM
install-GEMINI.exe /silent /dir=D:\PSG\GEMINI

where the /dir=... parameters end with the model name, have the same parent
directory, and contain no embedded blanks. If you use the /silent parameter,
you must also use the /dir=... parameter.

Second, in the above example, the SetEnv.exe program sets the environment
variables as system-wide (as opposed to user) environment variables. If, for some
reason you want to have the environment variables set as user environment
variables, then invoke the install programs using the /userenvvars command-
line parameter.

If you have any suggestions about how to make the PSG model install pro-
grams easier to use by IT staff, please send email to holmer@polsim.com with
your thoughts.
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Operation of PSG Models

This section of the primer provides answers to a number of “How do I . . . ?”
questions. It assumes that the PSG models have been installed and have passed
the benchmark tests (see section on model installation that begins on page 6).

How do I start working with the models? Use the RSF Toolkit, which
is started by clicking on the red “Tk” icon. Once the Toolkit has started, click
on the Getting Started with the RSF Toolkit item on the Help menu to read a
short tutorial.

How do I perform policy analysis with the models? Policy analysis
typically compares the results of two runs: one of which specifies a reference
policy (often current-law policy) and the other of which specifies a reform pol-
icy, with all other aspects of the two runs being the same. Using the models
to do policy analysis involves repeating a three-step cycle: specify a model run,
execute the model run, and analyze the output of the model run. The RSF
Toolkit provides access to all three activities in this policy analysis cycle. The
RSF Toolkit automates the process of run specification, provides capabilities of
executing runs that have been specified, and provides access to several other
Toolkits that automate the process of analyzing output produced by executed
runs. There are three output analysis toolkits: (1) the TFS Toolkit automates
the analysis of solvency consequences of reforms, (2) the EDA Toolkit auto-
mates the analysis of distributional consequences of reforms for a representative
cohort sample, and (3) the ECI Toolkit automates the analysis of distributional
consequences of reforms for a handful of exemplary cohort individuals.

How do I backup my work? Use the RSF Toolkit backup capability to
archive all run specification files, and other model-related files, in a zip file.
This archive file should be stored somewhere safe: on a network drive that gets
backed up every night or on a CD or in the cloud.

How do I . . . ? . . .

PLEASE SUBMIT SUGGESTED “HOW DO I . . . ?” QUESTIONS
TO holmer@polsim.com
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